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About eBook Librarian 

What You Need 

  

The eBook Librarian™ software helps you create and manage your library of eBook 
Editions™ for your RCA brand Gemstar eBook™ electronic reading device. eBook 
Editions are specially prepared electronic reading materials that you can buy from the 
Catalog or through an online bookstore. If you purchase eBook Editions from an online 
bookstore, you download them from the Internet to add them to the personal library 
stored on your computer.  

When you want to read an eBook Edition, you can download it using the modem or you 
simply send it from your computer to your eBook. The eBook Librarian software makes 
it easy. If you ever want to delete eBook Editions you've purchased from your library, it's 
no problem. You can always download them again whenever you have an Internet 
connection. You'll never have to buy the same edition twice! 

In addition to helping you manage your library, the eBook Librarian software lets you set 
some controls on your eBook. 

What You Need 

Your PC must satisfy the following requirements to work with the eBook: 

• PC with Windows 98 or Windows 2000  
• Minimum 16 MB of RAM recommended  
• At least 10 MB of available hard disk space  
• An Internet connection  
• A Web browser such as Netscape® Navigator or Internet Explorer  

NOTE: Even if you use a browser other than Internet Explorer, it is highly 
recommended that you install Internet Explorer (version 4.0 or greater) on 
your PC.  

Doing this should help some required software components to be available 
to the eBook Librarian's browser. You can still use the Web browser of 
your choice; the files simply need to be present on your computer to make 
the eBook Librarian fully functional. If you prefer not to install Internet 



Explorer, you can download required files from the 
http://www.gemstarebook.com/ Web site. 

• A USB port on your PC in addition to the Internet connection  

If your computer does not have a USB port, you'll need to purchase a USB PCI 
serial card from your local computer store. 

NOTE: If you choose to register via the Internet rather than the modem, 
your eBook must be connected to the USB port and at the same time you 
must have an Internet connection. After registration, simultaneous Internet 
and eBook connectivity is not required. 

If you have no way to satisfy the simultaneous connection requirement, 
see the Troubleshooting section on the http://www.gemstarebook.com/ 
Web site for an alternate registration procedure. 

If you have problems registering through your PC we recommend you 
register via the modem on your eBook. 
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In order to add new eBook Editions to your library and send them to your eBook using 
your computer, you need to take a few minutes to set up the connection between your 
eBook and your computer. 

http://www.gemstarebook.com/
http://www.gemstarebook.com/


Connecting Your eBook to Your Computer 

The first set-up task establishes the communications connection between your eBook and 
your computer. The eBook Librarian software will use this connection when, for 
example, you want to send an eBook Edition to your eBook. 

NOTE: You can also connect your eBook to your computer using an infrared (IR) port. 
See Using an Infrared Connection to find out more about this option. 

If you have a USB port: 

1. Turn on your eBook. 

2. Locate the USB port on your computer. 

3. Connect one end of the USB cable to your eBook. 

4. Connect the other end of the cable to the USB port on your computer. 

If you do not have a USB port: 

1. You must purchase a USB PCI serial card for your computer in order 
for the USB connection to work with your eBook. 

2. To install the card, refer to the instructions that came with it. 

3. Once it has been installed, proceed to connect your cable by following 
the previous instructions. 

Installing the eBook Librarian Software 

The second set-up task is installing the eBook Librarian software on your computer. 

1. Load the installation program onto your computer, and start it up. 

The installation software is provided on the CD and also can be 
downloaded from the Web. 

NOTE:  Gemstar updates the eBook Engine firmware and eBook 
Librarian software periodically. As a result, it is possible that the software 
provided on your CD is not the latest version. If you want to make sure 
you get the very latest features, use the download option. 

We recommend that you download the latest eBook Librarian software, 
eBook Engine firmware and User's Guides every so often from the Web. 
See Getting the Latest Software for more information. 



CD Option: Place the eBook Librarian CD in your computer's CD drive. 

The installation program should start up automatically 
when the CD is inserted. 

If the CD does not start automatically on your system, you 
can start it up manually as follows: 

a. Go to the Windows Start button and right-
click your mouse. 

b. Click on Explore. 

c. Find your CD-ROM drive in the left pane 
of the Exploring window. 

d. Right-click the menu and select Auto 
Play. 

The installation program starts up. 

Download Option: Download the eBook Librarian installer software from 
the Web. 

a. Open your Internet browser. 

b. Go to http://www.gemstarebook.com/. 

c. From here, click on Support, and then on Software 
Updates. 

d. Now click on the eBook Librarian software link. 

Your browser will display a download 
dialog box. Choose a location on your disk 
where you want to save the file, and save it. 
Then run Windows Explorer (right-click on 
the Start menu) and go to the location where 
you saved the downloaded file. Double click 
on the file to run the installation program. 

NOTE: As always, it is considered good 
practice to close any other applications that 
may be running before running the 
installation program. 

http://www.gemstarebook.com/


2. Follow the instructions on the screen to complete the installation. 

The last step of the installation asks if you want the system to launch the 
eBook Librarian for you. You can check this option if you'll be proceeding 
with the remaining set-up steps. 

NOTE: The eBook Librarian requires software components that are 
installed with Internet Explorer (version 4.0 or greater). If the installer 
detects that you do not have the required files, it will post a dialog box to 
inform you that the files are missing and direct you to install them first. 
You can obtain the required files either by 

• installing Internet Explorer (version 4.0 or greater)  
• installing them from the installation CD  
• installing them from http://www.gemstarebook.com/ (click on 

Support, then on Software Updates)  

Configuring eBook Librarian If You're on Corporate Intranet 

If you are using a computer at work, your Internet connection may go through a proxy 
server. A proxy server prevents outsiders from using the Internet to access your 
company's internal information. 

Check with your system administrator to find out if your company is using a proxy 
server. If so, you'll need to find out its address and port number. Your system 
administrator should be able to give you this information as well. You need to configure 
the proxy server's address and port so the eBook Librarian can access the Internet 
successfully. 

NOTE: The address and port information may already be entered in the 
Preferences or Options for "proxy setting" in your Web browser: 

• Internet Explorer: On the View menu, click Internet Options-
>Connection->Proxy Server.  

• Netscape Navigator (v. 4.x): On the Edit menu, click Preferences-
>Advanced->Proxies.  

If this information is present, it can simply be copied and pasted into the 
eBook Librarian configuration fields described in the following 
instructions. 

To enter the proxy server's address and port: 

1. From the eBook Librarian Settings menu, select eBook Librarian. 

2. Click on the Advanced button at the bottom of the screen. 

http://www.


The Advanced Setup window appears. 

3. Click on the check box labeled "Access the Internet using a proxy 
server." 

This allows you to type your information into the address 
and port fields. 

4. Type the address in the Address field and the port in the Port field. 

Example address: proxy.name.ours 

Example port: 8080 

The eBook Librarian should now be configured for use with the proxy server. Consult 
your system administrator if you have any problems. 

Registering Your eBook 

The last set-up task is registering your eBook. You need to register before you can 
purchase eBook Editions from an online bookseller. This is because each eBook Edition 
you buy is specially encoded so it can only be read with your specific eBook, and the 
registration process identifies you as the owner of your particular unit. The special 
encoding gives protection for both you and the author’s copyright, since it prevents 
copies of your eBook Editions from being redistributed illegally. 

When you register, an eBook Account is created for you on the eBook Web site. This 
account keeps track of all the eBook Edition purchases you make. At the same time, an 
eBook Certificate is generated for you online. The eBook Certificate includes an eBook 
ID and an encryption key. Without your eBook Certificate, you can't read encrypted, 
copyright-protected eBook Editions. 

The encryption key and eBook ID are automatically copied onto your eBook when you 
register. Your eBook ID identifies you as the owner of your eBook reading device. When 
you buy an eBook Edition, it is encoded specifically to be read with your encryption key.  

If you want to use more than one eBook with your eBook Librarian, you can only register 
one unit at a time. After all your eBooks are registered you can connect your eBooks at 
the same time. 

Your eBook ID and Password 

During registration, you will be given your eBook ID and asked to select and enter a 
password. When you buy eBook Editions from an online bookstore, you may need to 
enter both your eBook ID and password to identify yourself before your order can be 



processed. You will also need them both to access your account. Make sure you write 
down your eBook ID and password and store them in a safe place. 

If you ever forget your eBook ID after you register, you can just tap the Bookshelf icon 
and select About Your eBook. Your eBook ID will be displayed on this screen. If you 
lose your password, you can get help retrieving it on your eBook Account Web page. See 
Your eBook Account for more information. 

How to Register 

If you register using your computer, your eBook must be connected on one USB 
communications port and at the same time you must have an Internet connection. After 
registration, simultaneous Internet and eBook connectivity are not required. 

If you have no way to satisfy the simultaneous connection requirement, see the 
Troubleshooting section on the http://www.gemstarebook.com/ Web site under Support 
for an alternate registration procedure. Otherwise, continue with the following steps to 
register your eBook: 

If you are not connected to your computer, follow the Connecting Your eBook to Your 
Computer instructions. 

1. Connect to the Internet. 

If you're not already connected, establish your Internet 
network connection as you usually do. 

The eBook Librarian's status message should continue to 
be "Ready." If it now reads "Not ready," refer to the 
Troubleshooting section of the 
http://www.gemstarebook.com/ Web site under Support. 

2. From the eBook Librarian Online menu, select Register Now. 

The eBook Librarian now retrieves identification 
information from your eBook and sends it over the Internet 
to the registration Web site. Then the eBook Librarian's 
browser window is activated and pointed to the registration 
Web site. 

3. Enter the information requested in the registration form displayed in the 
browser window. 

When you finish entering your registration information, a 
Certificate is generated for you at the registration Web site. 
The Certificate is sent over the Internet to your eBook 

http://www.gemstarebook.c
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Librarian, which then forwards it to your eBook to 
complete the registration process. 

If you encounter any problems during registration, please 
see the Troubleshooting section of the 
http://www.gemstarebook.com/ Web site under Support. 

Your eBook is now registered, and you've been given an eBook Account that's accessible 
from the eBook Web site. 

Your eBook Account 

When you register your eBook, an eBook Account is created for you on the eBook Web 
site. Your eBook Account will keep a permanent record of all the eBook Editions you 
ever buy. You can use it to download your eBook Editions any time after you purchase 
them. 

Your eBook Account lets you: 

• Get the latest version of the eBook Librarian software.  
• Request a list of the eBook Editions you’ve purchased, and optionally download 

them again to your computer.  
• Review or update the customer profile information you entered.  
• Change your password.  
• Retrieve a lost password.  

To access your eBook Account: 

1. Open an Internet browser on your computer. 

You can use the eBook Librarian's browser window or any other Internet 
browser. 

2. Go to the eBook Web site at http://www.gemstarebook.com/. 

3. Click on Your eBook Account. 

Before you can view your purchases or customer information, you'll need to enter your 
eBook ID and password. If you're using the eBook Librarian's browser window, you can 
easily compare your list of purchases with the editions currently available from your 
eBook Librarian and download any editions that are missing. 

Your Web Site Resource 

When you purchase an eBook, you join a community of readers on the eBook Web site: 
http://www.gemstarebook.com/. The Web site provides the resources to help you make 

http://www.gemstarebook.com/
http://www.gemstarebook.com/
http://www.gemstarebook.com/


the most of your purchase. It provides the latest information on new products, software 
updates, technical support, current news of authors and books, retailers and much more. 
You can also give us feedback on our performance in providing you with the highest 
quality product. You can access the Web site using your eBook Librarian's browser 
window or any other Internet browser. 
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Starting eBook Librarian 

To start up the eBook Librarian software on your computer: 

1. Go to your Windows Start menu. 

2. Select Programs. 

3. Click on eBook Librarian. 

The eBook Librarian software starts up on your computer. 

The eBook Librarian Screen 



The eBook Librarian screen has three main sections: the toolbar section and the left and 
right panels. The left panel displays the list of eBook Editions in your library and the 
number of eBooks you have connected to the eBook Librarian. The right panel provides 
tabs for two separate views: one for the eBook Librarian's browser, and one for the search 
feature that helps you find particular eBook Editions. 

There are some message areas in the bottom border of the eBook Librarian window. 
When you move your cursor over a menu item or button, the message area at the left 
displays a description of the action it performs. 

The bottom message area displays the connection status. This lets you know whether or 
not the eBook Librarian detects your eBook USB connection. The possible connection 
status messages are: 

• Not ready: the eBook is not connected to the eBook Librarian  
• Busy: the eBook is performing a task that requires other tasks to wait  
• Ready: The eBook is ready for all tasks  



The Help menu (the right-most menu at the top of the screen) gives you easy access to 
this User's Guide, as well as to the "eBook User's Guide". 

Your eBook Editions List 

For each eBook Edition in your computer library, eBook Librarian displays related 
information provided by the publishers including author, title size and eBook ID. Note 
that you may have to scroll or resize the left panel to see all this information. If there are 
multiple authors, the name the publishers have chosen to list as the primary author will be 
displayed. Title size indicates the size (in kilobytes) of the title. The eBook ID identifies 
the owner of the eBook that is authorized to read this eBook Edition. 

The eBook Editions list also includes three status columns: 

• Not on Disk (denoted by a disk with a red X through it): A marker appears in this 
column for any eBook Edition that you've deleted from your hard disk.  

• On eBook:  A green eBook marker appears in this column if the eBook Edition is 
detected on your eBook.  

• Markups:  A check appears in this column if markups have been saved for the 
eBook Edition.  

Using the eBook Librarian's Browser Window 

Once you establish your network connection as you normally do, you can use the browser 
window in the eBook Librarian's right panel. The browser window lets you access the 
Internet without having to launch a separate program. This is useful, for example, when 
you want to obtain new eBook Editions or to review your eBook Account information. 

The Address Bar, located above the two eBook Librarian panels, shows the URL that's 
currently displayed in the browser window. You can enter a new URL simply by typing 
into the address bar. 

The Navigation Menu provides options that relate to using the eBook Librarian's browser. 
You can move forward or back screens, print or refresh the screen, and increase or 
decrease font sizes. The Online menu lets you register your eBook, update your software, 
or connect to the Customer Support Web site using the eBook Librarian's browser 
window. 

Customizing the Screen 

You can easily customize the eBook Librarian screen. For example, you can adjust the 
relative sizes of the right and left panels by clicking on the bar that separates them and 
dragging it to the left or to the right. You can sort your eBook Editions list based on any 
column by clicking on that column's title. Clicking the column's title again toggles 
between ascending and descending sort order. 



You can also adjust the appearance of the menu region. For example, you can choose to 
hide or display the toolbars, as you prefer, using the View menu. The toolbars provide 
shortcuts to frequently used menu items. One is for actions that pertain to eBook 
Editions, and another is for actions relating to the browser window.  

Additionally, you can change the location of the toolbars and address bar, and even 
change the order of the columns within the eBook Editions list. To move one of the 
toolbars or the address bar, click on the vertical bar to its left and drag it to a new 
location. To swap columns in the eBook Editions list, first resize the left panel so you can 
see all the columns. Then click and drag column headings to place them in the order you 
prefer. 
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eBook Librarian helps you when you want to check out eBook Editions from your 
computer library to read on your eBook, when you want to add new eBook Editions to 
your library, and when you want to search through your list to locate particular eBook 
Editions quickly. 

Checking Out eBook Editions 

When you want to read your eBook Editions, you need to send them to your eBook. 

Sending an eBook Edition to Your eBook 

To send an eBook Edition to your eBook: 

1. Connect your eBook to your computer through your USB connection. 



If you're using an infrared connection instead of the USB port, make sure 
the infrared ports are properly aligned. See Positioning Your eBook for 
more information. 

2. Start up the eBook Librarian on your computer. 

Make sure the "Ready" connection status message appears in the eBook 
Librarian  message area in the lower right border. 

3. Click on the eBook Edition(s) you want to send to the eBook. 

4. Send the eBook Edition to your eBook by clicking on the large Send Edition button. 

(Alternatively, you could select Send to eBook from the Edition menu.) 

5. Click on either the Send to Internal Memory or Send to Memory Card. 

If you did not insert a SMART MEDIA card in your eBook, you simply 
send the eBook Edition to Internal Memory. If you have a SMART 
MEDIA card inserted, you can send it to either the Internal Memory or 
your Memory Card. To check on available memory select About Your 
eBook from the Bookshelf icon. 

6. If you have more than one eBook connected to the eBook Librarian, the selected 
eBook Edition will be sent to both if there is no eBook ID assigned to it. If there is, the 
eBook Edition will only be sent to that specific eBook. 

Adding To Your Library 

You can add to your library by buying new eBook Editions or downloading freely 
available eBook Editions from the Web.  

Buying eBook Editions 

You can buy more eBook Editions by going to any online bookseller that offers eBook 
Editions for purchase. When you buy an eBook Edition from an online bookseller, you 
need to identify a specific, registered eBook for that purchase. Each eBook is identified 
by the eBook ID the owner received during registration. Any purchased eBook Edition is 
specially encoded for use with the identified unit only. 

NOTE: Buying eBook Editions through your eBook's modem is a 
separate purchase process. If you began to fill out the order form on your 
eBook, you can only complete this purchase through the modem. See the 
"eBook User's Guide" that came loaded onto your eBook for more 
information on purchasing eBook Editions through the modem. 



To buy eBook Editions: 

1. Open an Internet browser on your computer. 

You can use the eBook Librarian's browser window or any other Internet 
browser. 

NOTE: You can use the modem feature in your eBook to 
purchase eBook Editions directly. See the "eBook User's 
Guide" that came loaded onto your eBook for more 
information on using the modem feature. 

2. Go to an online bookstore that sells eBook Editions. Two such online booksellers are 
http://www.bn.com/ (Barnes & Noble) and http://www.powells.com/. 

You can do this by entering the URL for an online bookseller into your 
browser. 

3. Select the eBook Editions you'd like to purchase. 

Click on any of the books offered at the site that are identified as eBook 
Editions or marked with the eBook logo. 

4. Follow the directions for purchasing eBook Editions provided by the online bookstore. 

5. Enter your eBook ID if requested during the purchase. 

If you don't remember your eBook ID, you can find it in the 
About Your eBook window on your eBook. Tap the 
Bookshelf icon on the eBook to open this window. 

NOTE: If the bookseller does not request your eBook ID, 
your bookseller account must use the same email address as 
your eBook Account (this information was recorded when 
you registered your eBook). 

If you are purchasing eBook Editions through the Internet and once the transaction is 
complete, the bookseller provides you with an Internet browser URL or download link 
that you can use to pick up your purchase whenever it's convenient. The URL or link may 
be displayed immediately on your browser or sent to you later, via email. 

If you have any problems downloading an eBook Edition from the bookseller, you can 
always get it from your eBook Account. If you do not receive confirmation of your 
purchase from the bookseller, you can check for the new eBook Editions in your eBook 
Account purchase history after about half an hour. See Your eBook Account for more 
information on reviewing your purchase history and downloading your eBook Editions. 

http://www.bn.com/
http://www.powells.com/


Searching Your eBook Editions 

You can search through your library to locate particular eBook Editions quickly: 

1. Start up the eBook Librarian on your computer. 

2. Select the search feature view, if it isn't already displayed. 

Click on the Search tab at the top of the right panel. 

NOTE: You may also want to adjust the relative sizes of 
the two panels by clicking on the panel separator and 
dragging it to a different position. 

3. Select your search attribute(s). 

You can do either a simple search on one attribute, or an 
advanced search by using more than one attribute. When 
you select more than one search attribute, only the eBook 
Editions that satisfy all of them are displayed. 

The list of eBook Editions displayed in the left panel 
updates as you select each new search attribute. 

The possible search attributes are:  

• Category  

Matches all eBook Editions in the category 
you select. See Categorizing Your eBook 
Editions for more information. 

• Keyword    

Matches full or partial words in the eBook 
Edition, author, publisher or eBook ID fields 
as you type. 

• Author  

Matches eBook Editions with the author you 
choose from the pull-down menu. 

• eBook ID  



Matches eBook Editions for the eBook ID 
you choose from the pull-down menu. 

• On eBook  

Matches all eBook Editions found on your 
connected eBook when you select this 
checkbox. 

• Has Markups  

Matches all eBook Editions for which 
markups have been saved when you select 
this checkbox. 

NOTE: You can easily restore the display to your full 
eBook Editions list by clicking on the Show All Editions 
button. You can also use this button before you start a 
single attribute search (for example, when you want to 
search by category or by author only) to ensure that all 
other attribute fields are clear. 
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As your library grows larger, you may find it helpful to use some of the management 
facilities that the eBook Librarian provides. For example, you can categorize your eBook 
Editions to help you search through them easily. You can save your markups, so if you 
remove eBook Editions from your eBook, you won't lose the bookmarks, notes or 
underlines you entered. You can even use the eBook Librarian to get the latest eBook 
software updates. 

Categorizing Your eBook Editions 

eBook Librarian allows you to organize your eBook Editions so you can list them by 
category. Specifically, eBook Librarian allows you to assign an eBook Edition to a 
category, create a new category or subcategory, and reorganize your categories 

When you first get an eBook Edition, it is assigned to two categories by default: to the 
<New> category and to one other: 

• its genre category (if a genre was assigned by the publisher)  
• its subscription name (if it's a subscription)  
• <Unfiled> (if it has no genre and isn't a subscription).   

Note that you can clear out your <New> folder at any time by choosing Empty "<New>" 
category from the Categories menu. This does not delete any eBook Editions, but simply 
removes them from the <New> category and places them in the <Unfiled> category, 
leaving all other category information intact. After you empty the <New> category, any 
new eBook Editions you get later will be easy to find. 

Assigning an eBook Edition to a Category 

You can change an eBook Edition's category, or assign it to additional categories: 

1. In the left panel, select the eBook Edition(s) you want to categorize. 

If you want to select more than one eBook Edition, hold down the Ctrl key 
while you click on the eBook Editions. 

2. From the eBook Editions menu, choose Categorize. 

(As a quick alternative, you can right-click over the eBook Edition to 
display the eBook Editions menu, and choose Categorize from there.) 

NOTE: If necessary, you can increase the size of the left panel by clicking 
on the panel separator and dragging it to the right. 



eBook Librarian displays the Categorize Editions selection box. 

3. Click on the category you want to file the eBook Edition(s) under. 

If you want to file the eBook Edition(s) under more than one category, 
hold down the Ctrl key while you click on the categories. 

eBook Librarian files the eBook Edition(s) under the category or 
categories you selected. The next time you do a search on one of the 
selected categories, the eBook Edition(s) will appear in the list. 

Creating a New Category 

To create a new category or subcategory, 

1. Select the search feature view, if it isn't already displayed. 

Click on the Title List tab at the top of the right panel. 

2. Select where you want to add the new category. 

You can create a new top-level category by clicking on <All>, <New>, or 
<Unfiled>. Clicking on any other category will create a subcategory for it. 

3. From the Categories menu, choose Create. 

(As a quick alternative, you can right-click where you want to add the 
category. This displays the Categories menu, and you can choose New 
from there.) 

eBook Librarian creates a new category at the location you specified and 
provides a text entry field to let you specify the name. 

4. Type in a name for the new category. 

eBook Librarian updates the new category's name to the one you 
specified. 

Reorganizing Your Categories 

You can delete, move or rename your categories to reorganize your filing system: 

1. Select the search feature view, if it isn't already displayed. 

Click on the Search tab at the top of the right panel. 



2. Select a category you'd like to delete, move or rename. 

Note that the categories <All>, <New> and <Unfiled> are special, in that 
they can't be deleted, moved or renamed. 

3. Change the category as desired. 

Delete:  From the Categories menu, choose Delete. You can right-click 
on the category to display the Categories menu. 

eBook Librarian asks you to confirm your deletion request.  

If you answer OK, eBook Librarian deletes the category. 
eBook Editions that were assigned to other categories (in 
addition to the deleted category) will continue to appear in 
those other folders. eBook Editions that were assigned to 
that category only will now appear in the <Unfiled> 
category folder. 

Move:  From the Categories menu, choose Move. You can right-click on 
the category to display the Categories menu. 

eBook Librarian displays the Move Category selection box. 

Click on the location where you want to move the selected category. 
Clicking on <All>, <New>, or <Unfiled> will place the category at the top 
level. Clicking on any other category will place the category beneath it. 

Rename:  Left-click on the category again. 

eBook Librarian changes the category name to an editable field. 

Type in a new name for the category. 

NOTE:  If you rename a genre or subscription category, a new folder with 
the original name will be re-created the next time you download an eBook 
Edition of the same type. 

Capturing eBook Information 

You can have the eBook Librarian find out what eBook Editions are on your eBook and 
save any markups you've entered for those eBook Editions. 

Synchronizing With Your eBook 



If the eBook Librarian is running and the eBook is connected to your computer, the 
software can check to see what's on your eBook. Specifically it can find out what eBook 
Editions are present on the eBook and save any markups you have made. This is called 
synchronizing your eBook Librarian with your eBook. 

By default, the eBook Librarian displays the synchronization dialog box whenever it 
detects that you've connected your eBook. If your eBook is connected when you start the 
eBook Librarian, the synchronization dialog box also appears at startup. 

If you answer Yes to the synchronization dialog box, the eBook Librarian will save all 
markups on your eBook and update its display to show which eBook Editions are present. 
You can now see what eBook Editions you have on your eBook via the eBook Librarian. 
Just click on eBooks then click on the eBook icon with the appropriate eBook ID from 
where you want to view your eBook Editions. You can also delete eBook Editions from 
your eBook through the eBook Librarian, but to do this you must synchronize the eBook 
Edition markup information whenever you connect your eBook to the eBook Librarian. If 
you'd prefer to keep this information private to your eBook, you can answer No. For 
example, maybe you will be connecting your eBook on someone else's system and you 
don't want them to see your eBook Editions or have your markups. 

You can check the Do not ask me again box to have the eBook Librarian keep your 
current answer in effect from now on without prompting you for a reply. If your answer 
was Yes, the eBook Librarian will always update the "on eBook" Edition information and 
save your markups whenever it detects your eBook is connected to a computer. If your 
answer was No, it will never synchronize until you explicitly change the synchronization 
setting. 

The eBook Librarian remembers your synchronization setting (always, never, or prompt) 
and uses it every time your unit is connected. You can, however, change the 
synchronization setting at any time. 

To change the current synchronization setting: 

1. Start up the eBook Librarian on your computer. 

2. Make sure that the USB cable is still connected to your computer and 
that the other end is plugged into the eBook. 

If you're using an infrared connection instead of the USB port, make sure 
the infrared ports are properly aligned. See Positioning Your eBook for 
more information. 

In a few moments, the green connection "Ready" status message appears 
in the eBook Librarian message area (in its lower right border). 

3. From the eBook Librarian Settings menu, choose RCA eBook. 



If you have more than one eBook, each eBook is identified with its eBook 
ID. 

4. Click on the Misc tab. 

5. Select the synchronization setting you want. 

6. Click OK. 

eBook Librarian will use the synchronization setting you 
selected whenever it detects that you've connected your 
eBook to a computer. 

Removing Unwanted Items 

The number of eBook Editions you can save in your library depends on the amount of 
hard disk space you have access to on your computer. If you want to conserve space, you 
can remove eBook Editions from your computer. If you'd like, before you remove them 
you can save them to a floppy, for example. 

NOTE: Even if you don't save the eBook Editions you've purchased, you can always 
reclaim them by downloading them again from your eBook Account. See Your eBook 
Account for more information. 

Deleting eBook Editions 

To delete an eBook Edition from your computer: 

CAUTION: If you delete an eBook Edition from your computer, you'll 
also lose any markups you may have saved. 

1. Open the eBook Librarian on your computer. 

2. Select the eBook Edition(s) that you want to delete. 

3. Remove the selected eBook Editions. 

a. From the eBook Librarian Edition menu, select Remove From 
Library. 

eBook Librarian displays the Confirming Book Deletion screen. 

b. To delete the catalog reference, check the Remove all book 
information box. 



NOTE: Although you can delete an eBook Edition from your computer, 
it's a good idea to keep a record of it in your eBook Librarian. Keeping a 
reference in your eBook Librarian reminds you which eBook Editions 
you've already purchased for your eBook. 

If you don’t check this box, eBook Librarian will continue to list the eBook 
Edition in its display, but the "not on disk" indicator will be present. 

c. Click Yes to delete the eBook Edition. 

You can click on Yes to All to delete all selected eBook Editions, if you 
selected more than one. 

eBook Librarian deletes the eBook Edition along with its markups from 
your computer. 

Deleting eBook Editions From Your eBook 

You must synchronize your eBook Edition markup information when you connect your 
eBook with the eBook Librarian so the Librarian has the latest eBook Edition information 
on your eBook. 

1. Click on the eBook icon. A list of eBooks is located under the eBook 
icon in the left panel. 

2. Click on the eBook you want the eBook Edition deleted from. A list of 
eBook Editions on that eBook will be shown on the right panel. 

3. Select the eBook Edition you want to delete. 

4. Click on Delete from the Title menu. You can also right click on the 
eBook Edition and select Delete. 

Deleting Markups 

If you've saved markups for any of your eBook Editions, you can delete them from your 
hard disk if you no longer want them. The next time you send the eBook Edition to your 
eBook, it won't contain any markups. (This assumes that you also removed the previous 
marked up version from your eBook.) 

To delete an eBook Edition's markups: 

1. Start the eBook Librarian on your computer. 

2. Select the eBook Edition(s) with the markups you want to delete. 



3. Select eBook Edition from the eBook Librarian menu bar. 

4. Choose Delete Markups. 

eBook Librarian asks you to confirm your request to delete 
the markups. If you're sure you want to delete the markups, 
click Yes. Otherwise, click No. 

Getting the Latest Software 

Periodically, new software becomes available both for the eBook Librarian and for the 
eBook. When you update your software, you have access to all the current eBook features 
and functionality, along with the latest additions. To find out what's in the latest software 
version, visit the eBook Web site at http://www.gemstarebook.com/. 

We encourage you to get the latest software: 

1. Make sure that the USB cable is still connected to your computer and that the other end 
is plugged into the eBook. 

If you're using an infrared connection instead of the USB connection, 
make sure the infrared ports are properly aligned. See Positioning Your 
eBook for more information. 

2. Connect to the Internet as you usually do. 

3. Start the eBook Librarian on your computer. 

Make sure the "Ready" connection status message appears in the eBook 
Librarian  message area in the lower right border. 

4. Select Online from the eBook Librarian menu bar. 

5. Choose Update Now. 

This sends the latest firmware to your eBook and points the eBook 
Librarian's browser window to the software updates page. 

NOTE: If you get the latest firmware, it is important to continue with the 
following steps to download the latest eBook Librarian software. 

6. On your browser, click on Software Updates. 

7. Click on the eBook Librarian software link. 

http://www.gemstarebook.com/


Your browser window will display a download dialog box. Choose a 
location on your disk where you want to save the file. 

8. Close the currently running eBook Librarian. 

9. Run the installation program for the latest eBook Librarian software (the file you just 
downloaded). 

To run the eBook Librarian installation program, open Windows Explorer 
(right-click over the Start menu) and go to the location where you saved 
the downloaded file. Double click on the file to run it. 

10. Follow the on-screen instructions to complete the installation. 

 

Changing eBook Settings 

Choosing Fonts and Font Sizes 

Setting the Date & Time 

Setting the Automatic Shutoff Delay 

  

eBook Librarian lets you change some of the settings on your eBook. For example, you 
can change fonts and font sizes, set the date and time display on your eBook, and modify 
the amount of time the eBook waits idly before it shuts off automatically. 

Choosing Fonts and Font Sizes 

Your eBook is preset with two font sizes, one for large print and one for small print. If 
you don't like the two defaults, you can change them. Any of the fonts and sizes available 
on your computer can be used on your eBook. Once you’ve defined your large and small 
print display options, you can alternate between the two easily, as described in the eBook 
User's Guide. 

To select different fonts and sizes: 

1. Make sure that the USB cable is still connected to your computer and that the other end 
is plugged into the eBook. 



If you're using an infrared connection instead of the USB connection, 
make sure the infrared ports are properly aligned. See Positioning Your 
eBook for more information. 

2. Open the eBook Librarian software on your computer. 

Make sure the "Ready" connection status message appears in the eBook 
Librarian  message area in the lower right border. 

3. Bring up the Fonts selection screen. 

This screen lets you define a large font and a small font by choosing 
among a list of available fonts and sizes. 

a. From the eBook Librarian Settings menu, choose RCA eBook. 

b. Select the Font tab. 

The eBook Librarian displays the Font panel. 

4. Click on one or both check boxes to deselect the defaults, then select the fonts and 
sizes you want. You don't have to use the same typeface for both sizes. 

If you've already selected some different fonts and now you want to 
restore the defaults, click on the Default Font checkboxes. 

NOTE: Selecting any font other than the defaults uses up some of the 
internal memory in your eBook. The larger sized fonts use the most 
memory. Using the default fonts eliminates the extra memory needed for 
fonts and leaves the most room for your eBook Editions. 

Because larger fonts use more memory, we recommend you use no larger 
than 28 points. If you use 24 point or larger for your large print selection, 
we suggest that you choose 16 point or less for your small print selection. 
Following this guideline will ensure good performance. 

5. Confirm your selections by clicking OK. 

The eBook Librarian sends the font information to the eBook, and the text 
is redisplayed using the new font. 

See the "eBook User's Guide" located on your eBook for instructions on 
finding out how much memory is being used by fonts. 

Setting the Date & Time 



The date and time are displayed on your eBook in its Status window when you tap the 
Bookshelf icon and choose About Your eBook. You can set the date and time, and make 
choices about how they are displayed. 

1. Make sure that the USB cable is still connected to your computer and that the other end 
is plugged into the eBook. 

If you're using an infrared connection instead of the USB connection, 
make sure the infrared ports are properly aligned. See Positioning Your 
eBook for more information. 

2. Open the eBook Librarian. 

Make sure the "Ready" connection status message appears in the eBook 
Librarian  message area in the lower right border. 

3. Set the time and date, or change how they are displayed on your eBook. 

From the eBook Librarian Settings menu, select RCA eBook. 

To set the date and time: 

a. Select the Date & Time tab. 

b. Enter the appropriate information into fields to set the time and the date. 

If you want to synchronize the eBook time and date with your computer's 
system time, click Update Now in the box labeled "Use current system 
time." 

c. Click OK. 

Your eBook now displays the new time and date. 

To set the date and time formats: 

a. Select the Date & Time Format tab. 

b. Select the formats you want. 

Sample time and date displays show you how the time and date will 
appear for each of your selections. 

c. Click OK. 



Your eBook now displays the time and date in the formats 
you selected. 

Setting the Automatic Shutoff Delay 

The eBook shuts down automatically if you don't use it for ten minutes, to save the 
battery. If you'd like, you can change the period of time it waits before shutting down. 

To do this: 

1. Make sure that the USB cable is still connected to your computer and that the other end 
is plugged into the eBook. 

If you're using an infrared connection instead of the USB connection, 
make sure the infrared ports are properly aligned. See Positioning Your 
eBook for more information. 

2. Open the eBook Librarian. 

Make sure the "Ready" connection status message appears in the eBook 
Librarian  message area in the lower right border. 

3. Set the Auto Timeout value. 

a. From the eBook Librarian Settings menu, select RCA eBook 

b. Select the Misc tab. 

c. Under Auto Timeout, set the number of minutes you want the eBook to 
remain inactive before it shuts down. 

NOTE: A setting of zero disables this feature. 

d. Click OK. 

 

Using an Infrared Connection 

Setting Up Infrared Capability on Your PC 

Getting an Infrared Port 

Getting the Infrared Driver Software 



Configuring Your PC for Infrared Communications 

Configuring the eBook Librarian for an Infrared Port 

Positioning Your eBook 

  

Setting Up Infrared Capability on Your PC 

With an infrared connection, you simply aim your eBook at your PC and it's just the same 
as if there were a physical cable connection. In order to do this, though, you first need to 
configure both your computer and the eBook Librarian software for infrared 
communications. Then, when the infrared ports are properly lined up, your computer can 
beam eBook Editions to your eBook using infrared signals. 

Getting an Infrared Port 

Many laptop PCs now come with infrared ports built in. If your computer didn't come 
with one, you can still connect an external infrared transceiver to one of your PC's USB 
ports. The Actisys IR220L is one example of an external transceiver. 

Getting the Infrared Driver Software 

In addition to the infrared transceiver, you must also make sure infrared driver software is 
installed on your computer. This software comes preloaded with most versions of 
Windows 95, and all versions of Windows 98. If your PC has the infrared driver 
software, there will be an infrared icon in the control panel. 

If the infrared icon is missing and you're running Windows 95, you can 
download version 2.0 from http://www.actisys.com/: 

1. Download the software. 

a. Open an Internet browser and go to http://www.actisys.com/. 

You can use the eBook Librarian's browser window or any other Internet 
browser. 

b. Download version 2.0 of the infrared driver software. 

Find and click on the link that lets you download the latest Infrared 
software for Windows 95. Then click on irda20.exe. 

A download dialog box appears. Choose where you'd like the downloaded 
software to be saved. 

http://www.actisys.com/
http://www.actisys.com/


2. Install the software. 

a. Unpack and start up the installation program. 

Open Windows Explorer (right-click over the Start menu), find your 
downloaded file, and double click on it to run it. Select a location where 
you want to unpack the component files. Then click Unzip. In Windows 
Explorer, find the location you chose, and double click on setup.exe to run 
it. 

b. Follow the on-screen directions to complete the installation. 

Configuring Your PC for Infrared Communications 

Next, you need to configure your PC to enable infrared communications. You'll also be 
checking on serial port information here. 

1. From your Windows Control Panel, double click on the infrared icon. 

This brings up the Infrared Monitor. 

2. Select the Options tab. 

3. Make sure the box labeled "Enable infrared communication on:" is checked. 

4. Make sure the selected COM port matches the serial port your infrared transceiver is 
physically connected to. 

5. Make a note of the next line of text on the screen. 

The next line of text on the screen lists the virtual COM port for the 
infrared application. You'll need this information when you configure the 
eBook Librarian software. 

Configuring the eBook Librarian for an Infrared Port 

Configure the eBook Librarian software to use the correct serial port for infrared 
communications: 

1. Go to your Windows Start menu, select Programs, and click on eBook 
Librarian. 

2. From the eBook Librarian menu bar, choose Settings. 

3. Select eBook Librarian to bring up the list of serial ports. 



4. Select the COM port of the virtual COM port for the infrared 
application. 

You made note of this COM port in step 5 of Configuring Your PC 
for Infrared Communications. 

5. Click on the OK button. 

Positioning Your eBook 

For the infrared signals to be sent and detected properly, you need to line up the infrared 
ports on your eBook and your computer. 

1. Find the infrared port on the edge of your eBook, which is the power 
button. 

2. Make sure that your eBook is turned on. 

3. Position your eBook so its infrared port is pointing at the infrared port 
on your computer. 

The path between the two infrared ports needs to be clear 
of obstructions, and the two devices must be less than six 
feet apart. 

If the message "eBook not found" appears in the bottom 
right hand corner of the eBook Librarian, check that: 

• The Status tab in the Infrared Monitor on your 
computer lists the eBook as a device within range.  

• The virtual COM port is not in use by another 
application.  

If you have occasional problems sending eBook Editions to your eBook, your PC may be 
having trouble keeping up at the default communication speed, which is 115 kbps. If you 
think this might be the problem, bring up the Infrared Monitor from the Control Panel 
on your PC. Click on the box within the Options tab to enable "limit connection speed," 
and select 57.6 kbps in the pulldown menu. 

 

Other Information 
End-User License Agreement 



FCC & Industry Canada Statements 

END-USER LICENSE AGREEMENT 

IMPORTANT--READ CAREFULLY: This End-User License Agreement 
("Agreement") is a legal contract between you and Gemstar eBook Group Limited 
("Vendor") for eBook System Software, which includes computer software embedded in 
the electronic reader device and, as applicable, associated media, personal computer 
software intended for use in connection with the electronic reader device, printed 
materials, and "online" or electronic documentation (collectively referred to as the 
"Software Application"). 

BY USING, INSTALLING, OR OTHERWISE OPERATING THE SOFTWARE 
APPLICATION YOU AGREE TO BE BOUND BY THE TERMS OF THIS 
AGREEMENT, INCLUDING THE WARRANTY DISCLAIMERS, LIMITATIONS OF 
LIABILITY AND TERMINATION PROVISIONS BELOW, and the provisions relating 
to third party purchases. IF YOU DO NOT AGREE TO THE TERMS OF THIS 
AGREEMENT, DO NOT USE, INSTALL OR OTHERWISE OPERATE THE 
SOFTWARE APPLICATION. IF YOU HAVE BEGUN THE PROCESS OF 
INSTALLING THE SOFTWARE APPLICATION AND DO NOT AGREE TO THE 
TERMS OF THIS AGREEMENT, CANCEL AND EXIT NOW. 

Subject to the terms of the manufacturer's limited warranty and subject to the retailer's 
refund policy, if you do not agree to the terms of this agreement, you may participate in 
the retailer's refund policy for the Software Application and the electronic reader device 
by returning the device including any media and materials in an unused condition within 
thirty (30) days of purchase to the place of purchase. 

License Terms 

Following acceptance of this Agreement, you may execute, install and use one (1) 
registered copy of the Software Application for your own personal, individual use. 

Use on a reader device. You may use the single registered copy of the Software 
Application only with the electronic reader device and electronic distribution system, 
authorized by Vendor. 

Use on a PC. You may install the single registered copy on one hard disk or other storage 
device for one computer, and you may access and use the Software Application at that 
location so long as only one copy of the Software Application is in operation. If you are a 
private business rather than an individual, you may authorize the personnel associated 
with your business to use the Software Application, but only one person at a time, on one 
computer at a time. The primary user of the computer on which the Software Application 
is installed may make a second copy for his or her exclusive use on a backup or portable 
computer, so long as each registered copy of the Software Application is used on only 
one computer at a time. 



OTHER LIMITATIONS 

You may not rent, lease or lend the Software Application. 

You may not reverse engineer, decompile, or disassemble the Software Application, 
except and only to the extent that such activity is expressly permitted by applicable law 
notwithstanding this limitation. 

Vendor may provide you with support services related to the Software Application 
("Support Services"). Use of Support Services is governed by Vendor policies and 
programs described in the user manual, in "online" documentation, and/or in other 
Vendor-provided materials. Any supplemental software code provided to you as part of 
the Support Services shall be considered part of the Software Application and subject to 
the terms and conditions of this Agreement. With respect to technical information you 
provide to Vendor as part of the registration of your license to the Software Application 
or in connection with the Support Services, Vendor may use such information for its 
business purposes, including for product support and development. 

You may permanently transfer all of your rights under this Agreement, provided that you 
retain no copies, you transfer all of the Software Application (including all component 
parts, the reader device, the media and printed materials, any upgrades and your 
registration), and the recipient agrees to the terms of this Agreement. 

You may not translate, reverse engineer, decompile, disassemble or otherwise create 
derivative works of the Software Application or attempt in any way to obtain the 
Software Application source code. 

You may not modify the Software Application or any portion thereof, or merge all or any 
part of the Software Application with another program. 

You may not alter, obscure or remove any labels or proprietary marks or notices on any 
portion of the electronic reader device or on any portion of the Software Application. 

Without prejudice to any other rights, Vendor may terminate this Agreement if you fail to 
comply with the terms and conditions of this Agreement or if you violate Vendor's 
"Acceptable Use Policy" which Vendor posts at http://www.gemstarebook.com/ In such 
event, you must destroy all copies of the Software Application and all of its component 
parts, and Vendor may suspend or deactivate your use of the Software Application with 
or without notice. 

CATALOG AND THIRD PARTY PURCHASES 

Online Purchases: 

Purchases via eBook device using the Catalog. The eBook requires access to an analog 
telephone line for download of content as well as access to a 110-220vac 50-60Hz power 

http://www.gemstarebook.com/


source for battery recharging. In addition you must register and activate your eBook and 
provide a valid credit card that will be charged for content purchases. It is important that 
you maintain a valid credit card. You must be at least 18 years of age to place an order. 
All purchases are billed to your credit card on a per-transaction basis. 

Purchases via Personal Computer. All purchases of goods through an online store, using 
the Librarian Software, are subject of the terms and conditions of the respective store 
accessed via the Internet. Under no circumstances shall Gemstar eBook Technologies be 
liable for any claim related to such a purchase. 

Third Party Goods: 

Gemstar eBook Group Limited is not the publisher, producer, manufacturer or supplier of 
any of the content, merchandise, and services provided through the catalog. All content, 
merchandise, and services are supplied by third parties. Any opinions, advice, statements, 
services, offers, or other information expressed or made available by third parties, are 
those of the respective authors or distributors and not of Gemstar eBook Group Limited. 
Gemstar eBook Group Limited does not guarantee the accuracy, completeness, or 
usefulness of any third party goods, not its merchantability or fitness for any particular 
purpose. Under no circumstances shall Gemstar eBook Group Limited or its affiliates, or 
any of their officers, directors, employees, or agents are liable for any loss, damage or 
harm caused by a User's reliance on information obtained through the catalog. It is the 
responsibility of the User to evaluate the information, opinion, advice, or other Content 
available through the catalog. 

Termination of Third Party Purchase and Catalog Usage: 

Gemstar eBook Group Limited cannot prohibit minors from using the eBook and/or the 
catalog. Gemstar eBook Group Limited must rely on parents, guardians and those 
responsible for supervising minors to decide which materials are appropriate for such 
minors to view and/or purchase. Gemstar eBook Group Limited requires that all 
purchases be made by individuals 18 years of age or older. 

PROPRIETARY RIGHTS 

Copyright. All title and copyrights in and to the Software Application (including, without 
limitation, any images, photographs, animations, video, audio, music, text, and "applets" 
incorporated into the Software Application), the accompanying media and printed 
materials, and any copies of the Software Product are owned by Vendor or its suppliers. 
The Software Application is protected by copyright laws and international treaty 
provisions. Therefore, you must treat the Software Application like any other copyrighted 
material, subject to the provisions of this Agreement. 

Catalog Information. User acknowledges that the catalog may contain information, data, 
software, photographs, videos, typefaces, graphics, music, sounds, and other material 
(collectively "Content") that are protected by copyrights, trademarks, trade secrets, or 



other proprietary rights, and that these rights are valid and protected in all forms, media 
and technologies existing now or hereinafter developed. User may not modify, remove, 
delete, augment, add to, publish, transmit, participate in the transfer or sale of, create 
derivative works from, or in any way exploit any of the Content, in whole or in part. User 
may not upload, post, reproduce, or distribute in any way Content protected by copyright, 
or other proprietary right, without obtaining permission of the owner of the copyright or 
other proprietary right. The unauthorized submission or distribution of copyrighted or 
other proprietary Content is illegal and could subject the User to criminal prosecution as 
well as personal liability for damages in a civil suit. User will be liable for any damage 
resulting from any infringement of copyrights or proprietary rights, or from any other 
harm arising from such submission. 

U.S. Government Restricted Rights. The Software Application and documentation are 
provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights 
in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subparagraphs (c)(1) and (2) of the Commercial Computer Software - Restricted Rights at 
48 CFR 52.227-19, as applicable. Manufacturer for such purpose is Gemstar eBook 
Group Limited. 

Submissions. Should you decide to transmit to Vendor's website or to any website 
supporting the electronic distribution authorized by VENDOR by any means or by any 
media any materials or other information (including, without limitation, ideas, concepts 
or techniques for new or improved services and products), whether as information, 
feedback, data, questions, comments, suggestions or the like, you agree such submissions 
are unrestricted and shall be deemed non-confidential and you automatically grant 
Vendor and its assigns a non-exclusive, royalty-free, worldwide, perpetual, irrevocable 
license, with the right to sublicense, to use, copy, transmit, distribute, create derivative 
works of, display and perform the same. 

DISCLAIMER OF WARRANTY 

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE PROVIDED "AS 
IS". VENDOR AND ITS SUPPLIERS DO NOT AND CANNOT WARRANT THE 
PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE 
SOFTWARE OR SUCH FILES. VENDOR AND ITS SUPPLIERS MAKE NO 
WARRANTIES, EXPRESS OR IMPLIED, AS TO TITLE OR INFRINGEMENT 
OF THIRD-PARTY RIGHTS, MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR PURPOSE. 

Good data processing procedure dictates that any program be thoroughly tested 
with non-critical data before relying on it. The user must assume the entire risk of 
using the Software Application. ANY LIABILITY OF VENDOR FOR A 
DEFECTIVE COPY OF THE SOFTWARE APPLICATION WILL BE LIMITED 
EXCLUSIVELY TO REPLACEMENT OF YOUR COPY OF THE SOFTWARE 
APPLICATION WITH ANOTHER COPY OR REFUND OF ANY INITIAL 



LICENSE FEE VENDOR RECEIVED FROM YOU FOR THE DEFECTIVE 
COPY OF THE SOFTWARE APPLICATION. IN NO EVENT WILL VENDOR 
OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 
INCIDENTAL OR SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS 
OR LOST SAVINGS, EVEN IF A VENDOR REPRESENTATIVE HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM 
BY ANY THIRD PARTY. 

User expressly agrees that use of the catalog is at User's sole risk. Neither Gemstar 
eBook Group Limited nor its affiliates, nor any of their officers, directors, or 
employees, agents, third-party content providers, merchants, sponsors, licensors 
(collectively, "Providers"), or the like, warrant that the catalog will be 
uninterrupted or error-free; nor do they make any warranty as to the results that 
may be obtained from the use of the catalog or as to the accuracy, reliability, or 
currency of any information content, service, or merchandise provided through the 
catalog. 

THE CATALOG IS PROVIDED BY GEMSTAR EBOOK GROUP LIMITED ON 
AN "AS IS" AND "AS AVAILABLE" BASIS. GEMSTAR EBOOK 
TECHNOLOGIES MAKES NO REPRESENTATIONS OR WARRANTIES OF 
ANY KIND, EXPRESS OR IMPLIED, AS TO THE OPERATION OF THE 
CATALOG, THE INFORMATION, CONTENT, MATERIALS OR PRODUCTS, 
INCLUDED IN THE CATALOG. TO THE FULL EXTENT PERMISSIBLE BY 
APPLICABLE LAW, GEMSTAR EBOOK GROUP LIMITED DISCLAIMS ALL 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. GEMSTAR EBOOK GROUP LIMITED WILL NOT 
BE LIABLE FOR ANY DAMAGES OF ANY KIND ARISING FROM THE USE 
OF THE CATALOG, INCLUDING BUT NOT LIMITED TO DIRECT, 
INDIRECT, INCIDENTAL PUNITIVE AND CONSEQUENTIAL DAMAGES. NO 
ORAL ADVICE OR WRITTEN INFORMATION GIVEN BY GEMSTAR 
EBOOK TECHNOLOGIES NOR ITS AFFILIATES, NOR ANY OF THEIR 
OFFICERS, DIRECTORS, EMPLOYEES, AGENTS, PROVIDERS, OR THE 
LIKE, SHALL CREATE A WARRANTY; NOR SHALL USER RELY ON ANY 
SUCH INFORMATION OR ADVICE. 

Under no circumstances shall Gemstar eBook Group Limited or any other party 
involved in creating, producing, or distributing the catalog be liable for any direct, 
indirect, incidental, special, or consequential damages that result from the use of or 
inability to use the catalog, including but not limited to reliance by a User on any 
information obtained from Gemstar eBook Technologies or that result from 
mistakes, omissions, interruptions, deletion of files, errors, defects, viruses, delays in 
operation or transmission, or any failure of performance, whether or not resulting 
from acts of God, communications failure, theft, destruction, or unauthorized access 
to Gemstar eBook Group Limited records, programs, or services. User hereby 



acknowledges that this paragraph shall apply to all content, merchandise, and 
services available through the catalog. 

Some states or jurisdictions do not allow the exclusion or limitation of incidental, 
consequential or special damages, or the exclusion of implied warranties or 
limitations on how long a given warranty may last, so the above limitations may not 
apply to you. 

GOVERNING LAW 

This Agreement shall be governed by the laws of the State of California. 

DISPOSAL WARNING: The rechargeable battery in the eBook could explode if the 
unit is disposed of in high temperatures or flames. 

FCC and Industry Canada Statements 

U.S. Federal Communication Commission (FCC) Statement 

This device complies with part 15 of the FCC Rules. Operation is subject to the following 
two conditions: (1) This device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may cause undesired 
operation. 

This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. It has been tested and found to comply with the limits for a Class 
B digital device pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential installation. 
However, there is no guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following measures: 

- Reorient or relocate the receiving antenna. 

- Increase the separation between the eBook and receiver. 

- Connect the eBook power adapter to an outlet on a circuit different from that to which 
the receiver is connected. 

- Consult an experienced radio/TV technician for help. 

Any unauthorized changes or modifications to the eBook could void the user's authority 
to operate the equipment. 



Note: This equipment complies with Part 68 of the FCC Rules. On the rear panel of this 
equipment is a label that contains, among other information, the FCC Registration 
Number and Ringer Equivalence Number (REN) for this equipment. You must, upon 
request, provide this information to your telephone company. 

Connection to the telephone network should be made by using standard modular 
telephone jacks, type RJ11C. The RJ11C plugs and/or jacks must comply with FCC Part 
68 rules. 

If your telephone equipment causes harm to the telephone network, the Telephone 
Company may discontinue your service temporarily. If possible, they will notify you in 
advance. But if advance notice isn't practical, you will be notified as soon as possible. 
You will be informed of your right to file a complaint with the FCC. 

Your telephone company may make changes in its facilities, equipment, operations or 
procedures that could affect the proper functioning of your equipment. If they do, you 
will be notified in advance to give you an opportunity to maintain uninterrupted 
telephone service. 

This equipment may not be used on coin service provided by the telephone company. 
Connection to party lines is subject to state tariff. 

If you experience trouble with this telephone equipment, please contact Thomson 
Customer Service at the address and phone number listed below. The telephone company 
may ask that you disconnect this equipment from the network until the problem has been 
corrected or until you are sure that the equipment is not malfunctioning. 

Do not disassemble this equipment. It does not contain any user-serviceable parts. 

Model: RCA brand Gemstar eBook REB1100 

Responsible Party: Thomson Consumer Electronics 

Address: 10330 North Meridian Street, Indianapolis, IN 46290 U.S. 

1-800-386-7389 

http://www.gemstarebook.com/ 

Industry Canada (IC) Statement 

This digital apparatus does not exceed the Class B limits for radio noise emissions from 
digital apparatus set out in the radio interference regulations of Industry Canada. 

NOTICE: The Industry Canada Label identifies certified equipment. This certification 
means that the equipment meets certain telecommunications network protective, 

http://www.gemstarebook.com/


operational and safety requirements, as prescribed in the appropriate terminal equipment 
requirement document(s). The Department does not guarantee the equipment will operate 
to the user's satisfaction. 

Before installing this equipment, users should ensure that it is permissible to be 
connected to the facilities of the local telecommunications company. The equipment must 
also be installed using an acceptable method of connection. In some cases, the company's 
inside wiring associated with a single line individual service may be extended by means 
of a certified connector assembly (telephone extension cord). The customer should be 
aware that compliance with the above conditions may not prevent degradation of service 
in some situations. 

Repairs to certified equipment should be made by authorized Canadian maintenance 
facility designated by the supplier. Any repairs or alterations made by the user to this 
equipment, or equipment malfunctions, may give the telecommunications company cause 
to request the user to disconnect the equipment. 

Users should ensure for their own protection that the electrical ground connections of the 
power utility, telephone lines and internal metallic water pipe system, if present, are 
connected together. This precaution may be particularly important in rural areas. 

CAUTION: Users should not attempt to make such connections themselves, but should 
contact the appropriate electric inspection authority, or electrician, as appropriate. 

The Ringer Equivalence Number (REN) assigned to each terminal device provides an 
indication of the maximum number of terminals allowed to be connected to a telephone 
interface. The termination on an interface may consist of any combination of devices 
subject only to the requirement that the sum of the Ringer Equivalence Numbers of all 
the devices does not exceed 5. 

Model: RCA brand Gemstar eBook REB1100 

Responsible Party: Thomson Consumer Electronics Canada, Inc. 

Address: 6200 Edwards Blvd., Mississauga, ON, L5T 2V7 Canada 

1-905-405-3023 

TOCOM 15670750 
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